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MQ Accessory Shield

B P F#

= R B A

Accessory Shield 2125 T4 Arduino JF & — 3K AMEY Feb, 2R FANE T — 14K,
HiBhFH P 4658 Arduino 77 i R 2 ST RV & 3

FEIIRE

Tl AT
CIRGLeRbA
I 5

Z ¥ LED

TR AR IR
I
e i S B
0.96 ~I' OLED
XBee %1
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sTaTE PR X
EASYLINK RESET  [oT) fren *x @
‘ I T T

.

[0l

Arduino

D7 fE B NS Fi Arduino 2 1 FEAR
XBee ¥

Ji BN Tl XBee (B5B1HL

(#3151

0.96inch OLED
TIAEHEAT & AR SE0G, )P 12864
RGB LED

LI = K64 LED, W] LAEIR 256x256%256
T

B %

PWM JEH:, BEIHZE MR A& R

10K FT i A8

ADXL345

ShhnE g vE, W& ATk +16g
LM75BDP

REALRES, PrnTik 0.125C

10.
11.
12.
13.
14.

15.

16.

17.

1. WBHER

HAIEFF

by T AL BARET, s Bk
XBee W& SIT

IR RIT

XBee EASYLINK %42
Arduino f1 XBee & {i #%4gt
DS3231

FERE L S I

CR1220 Hith R

ST AR ik

P9813

RGB LED IXa)I5

[BkLk]

W/ B BB

Bk FE TXD 15 TX, RXD 5 RX AR, wl{#
FI_EREHLER A5 Arduino FE 45 BR H L6
XBee iHAF AT XA B

L% F TXD 5 RX, RXD 5 TX MR, ATiE
i Arduino EFEHR 5 115 XBee 15 F ik
178w AE
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2.1 T4 Arduino IDE FUFEARIRAE, WIEHIT B2 ERIA. BFRHEMTE; 2.2 HH
PRI H A DIRERIBRAE TEA SRR . SO A A BT &AM Arduino UNO PLUS, %T
ERHAERIESE xR,

2.1. Arduino IDE BYfF H

2.1.1. ERE N

KFMLL Arduino 1.0.6 Fo 222 kA HI3E T H . FTJF arduino-1.0.6.exe.

. drivers 2015/1/21 9:49
| examples 2015/1/21 9:49
.. hardware 2015/1/21 9:49
Ll java 2015/1/21 9:49
L lib 2015/1/21 9:49
. libraries 2015/1/21 9:49
. reference 2015/1/21 9:49
1. tools 2015/1/21 9:49
arduino_debug.exe 2014/9/16 15:46
€D arduino-1.0.6.exe 2014/9/16 15:46
) cygiconv-2.dll 2014/9/16 15:46
%] cygwinl.dll 2014/9/16 15:46
%/ libusb0.dll 2014/9/16 15:46
| revisions.txt 2014/9/16 15:46
%] txSerial.dll 2014/9/16 15:46

i File -> Preferences, 3 ABCLE FiH :

fRA v1.2, 201545 H 7 H
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9 sketch_feb06a | Arduino 1
‘ Edit Sketch Tools Help
New Ctrl+N

Open... Ctrl+O
Sketchbook

Examples

Close Ctrl+W
Save Ctrl+S

Save As... Ctrl+Shift+S
Upload Ctrl+U
Upload Using Programmer  Ctrl+Shift+U

Page Setup Ctrl+Shift+P
Print Ctrl+P

Preferences Ctrl+Comma <

Quit Ctrl+Q

Arduino Uno on

PR BIFE T H I libraries U & il 1] Sketchbook location Firi Al ff) S & 4 «

» Preferences. L | ||

Sketchbook location:

Z:\Users'\Administrator'\Documents'\Arduino| | Br <
Editor language: 'English (English) v. (requires restart of Arduino)
Editor font size: 14 (requires restart of Arduino)

Show verbose output during: [ | compilation [jupload

71

|¥|Display line numbers

@Verify code after upload

DUse external editor
‘ [¥] Check for updates on startup
EUpdate sketch files to new extension on save (. pde - .ino)

@Automatically associate .ino files with Arduine

can be edited directly in the file
:\Users\Administrator\AppData'\Roaming'Arduino'preferences. txt
(edit o

More prefere

¥ when Arduino 1s not running)

0k | [ cenca

HIFAMF, il Sketch -> Import Library, ZE &7 H adxI345. ds3231. Im75. rgb_p9813
A ssd1306 LT A, UiHIPE S AR,
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@ sketch_feb06a | Arduino 1.0.6 =

Tools Help

Verify / Compile

Ctrl+R

Show Sketch Folder Ctrl+K
Import Library... » Add Library...
Add File...

sketch)

1
EEPROM
Esplora
Ethernet
Firmata
GSM
LiquidCrystal
Robot_Control
Robot_Motor
RobotIRremote
SD
Servo

SoftwareSerial

H SPI

Stepper

TFT

WiFi

Wire

Contributed

adx|345

ds3231

Im75

rgb_p9813

ssd1306

Arduino Uno on COM4

2.1.2. EFRmIFMTE

1) UNO PLUS JT &) BOOT AU B # ON #4, VCC ML E N 5V.

2)  #E Accessory Shield B, @it USB ZeiEHIT KM HE N RN . 5 R FL YR 4R 7R KT
ML TAEIER .

3)  ATFEA Arduino IDE H 45 IR~ 012 7 KA IR AR 1 (10 9 18 S T 80777 K IR sy File ->
Example -> 01.Basics -> Blink B 7] T FF A~ B RE -

MAs vi.2, 2015 4E5 H 7 H
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4)

5)

@ sketch_feb06a | Arduino 1.0.6

liEditr Sketch Tools Help
New Ctrl+N
Open... Ctrl+0
Sketchbook

P Examples >

Close Ctrl+W
Save Ctrl+S
Save As... Ctrl+Shift+S
Upload Ctrl+U
Upload Using Programmer  Ctrl+Shift+U
Page Setup Ctrl+Shift+P
Print Ctrl+P
Preferences Ctrl+Comma
Quit Ctrl+Q

A5 Tools -> Board -> Arduino Uno
Z Ja AR AR 2 B E AL S .

f‘ Blink | Arduino 1.0.6
[Tools] Help

Ctrl+T

Auto Format
Archive Sketch
Fix Encoding & Reload

01.Basics

AnalogReadSerial

02.Digital » BareMinimum
03.Analog » 3 Blink
04.Communication » DigitalReadSerial
05.Control » Fade
06.Sensors » ReadAnalogVoltage
07.Display »

08.Strings »

09.UsB »

10.StarterKit >

ArduinolSP

EEPROM »

Esplora »

Ethernet »

Firmata »

GSM »

LiquidCrystal »

Robot_Control »

Robot_Motor 3

SD >

Servo »

Aites e

EFE Arduino FFRIRA S, XHEHA

g the documentation at http://arduine.cc

10 This ample code iz in the public domain.
11

12 modified 8 May 20

13 by Scott Fitzgerald

s Tools -> Serial Port -> COM4 B2 & Arduino JF &AMA F#EH,

17 Serial Monitor Ctrl+Shift+M ‘
2 Blink T
[ ‘
3 Turns on J» Board > © | Arduino Uno -
4 Serial Port P‘ Arduino Duemilanove w/ ATmega328
£ . | Arduino Diecimila or Duemilanove w/ ATmegal68
5  Most Ardy Programmer 4|
= Arduino Nano w/ ATmega328
6 Leonardo) Burn Bootloader y
7 pin the on-board LED 1is connected to on your AeduinoiNancw/iiimenaths

Arduino Mega 2560 or Mega ADK
Arduino Mega (ATmegal280)
Arduino Leonardo

Arduino Esplora

Arduino Micro

Arduino Mini w/ ATmega328
Arduino Mini w/ ATmegal68
Arduino Ethernet

Arduino Fio

Arduino BT w/ ATmega328

Arduino BT w/ ATmegal68

LilyPad Arduino USB

LilyPad Arduino w/ ATmega328

LilyPad Arduino w/ ATmegal68

Arduino Pro or Pro Mini (5V, 16 MHz) w/ ATmega328

=
IS

COM4 ZAHRAEANFI RN T AR, 5 20 B4 PR R B BRI 15

MAs vi.2, 2015 4E5 H 7 H
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9 Blink | Arduino
File Edit Sketch Help

Auto Format Ctrl+T
Archive Sketch
Fix Encoding & Reload

Serial Monitor Ctrl+Shift+M
Blink

>
Turns on| Board e

B Serial Port » comi |

\ V| COMig |*
Most Ardy Programmer 45 7’—]
|

Leonard Burn Bootloader jm:wf Ye unsure
pin the ~board LED is connected to on your Arduino model,

the documentation at http://arduinoe.cc
This example code is in the public domain.

modified 8 May 2014

v Scott Fitzgerald

Arduino Uno on COM4

6) )ﬁjﬁéﬁi%ﬁ%%ﬂ', THUGS FERET . WA RRIE, 2 3E75"“Done compling” A1ZE ]

SCAERAN

MAs vi.2, 2015 4E5 H 7 H



{u% B
\ wilhel e
ACC(—."SSOFV Shield ﬁﬁF‘ %Eﬂﬂ' WAVESHARE ELECTRONICS

@ 8link | Arduino 1.0.6
&

Blink

Turns on an LED on for one second, then off for one second, repeated]

Most Arduinos have an on~board LED you can control. On the Uno and
Leonardo, it is attached to digital pin 13. If you're unsure what
pin the on~board LED is comnected to on your Arduino model, check

the documentation at http://arduinoe. cc

This example code is in the public domain.

byte maximum)

Arduino Uno on COMS

7) )ﬁ%?%ﬂﬁ%ﬂ., TR N LT . 45054 5 UNO PLUS #R %% LED LA 1 #0E HiJT
GINKR, VHHREF R Elsh, B17IEW .

2.2, R
TEFAT R SIS 2 /T, EMRBIRR P IRE E L EM SN
2.2.1. AEEF

Joystick 5 M7 IR, GFE L. T, £, AUURIE. BN E# 555 Arduino BT 5
JEERE, B 10 T I H PR W RN e L T

BAENIE
9 PEIF T HFER %ﬂﬁ., 77T Arduino IDE 47 {78 I EALER « FEFFISAT I R LED

2 UL 1R IR, R RAE IR T “iE MEE—MER, f RS ErRY
A% FHIEEAL, 1T “you press UP”. LG W N

MAs vi.2, 2015 4E5 H 7 H



Il ==
. 1?11 EEEH
Accessory Shield ﬁa)ﬁ EJ:*ﬂﬂ‘ WAVESHARE ELECTRONICS

vou press UP

you press UP

you press RIGHT
vou press DOWN
vou press LEFT
vou press ENTER
vou press ENTER
vou press DOWIT

vou press ENTER

Fmtoscroll :Neuline v: :9600 baud v:

2.2.2. A[AHBELE

UNO PLUS FF &R 305 H 2K il ATMEGA328P-AU, iZ%:th Fr Bt H L EYa [, 38 3.3V K¢ 5V
fites, P 10 7 AD F#uibite, FrLAnTiEfit 2010=1024 HBEFEH . M RGHIMEEA 3.3V
iF, 6hR 4 HE R AT DAL E] 3300my /1024 = 3.22mv, B4R AD {H/CEE 3.22mv; 75 5V
fiteL, ¥4 5000mv /1024 = 4.88mv, &> AD RFHEACE 4.88mv.

Accessory Shield # %5 1) 10k 7T 1 H1 47 28 K F 3.3V £k H, B S K mT 18 5 4 HH 1 H R AELR 3.3V,
LR G E N 3.3V, Hith AD EIVEREZ 0-1023; AP AR L R RCE N
5V, BEI ADC 7 HER 0N 4.88mv, HLAL A% Kt L 3.3V XS RS AD N 3300/ 4.88
=676, Hlfit AD {H 1 & 0-676.

BIFMBLS:

9 T TR $fﬁ., 77T Arduino IDE H 47 (783 FUERLES . REPIs AT AT LA 324
HITFRFE AD B, BeFCrALE:, HthE AR A s, BRI TE:

MAs vi.2, 2015 4E5 H 7 H
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- -
coma [E=E] =

The current ADC walue is: 875 -
The current ADC value is: 675
The current ADC walue is: 876
The current ADC value is: 675
The current ADC walue is: 676
The current ADC wvalue is: 675
The current ADC wvalue is: 452
The current ADC value is: 452

m

The current ADC value is: 437
The current ADC wvalue is: 436
The current ADC value is: 438
The current ADC wvalue is: 438 L

The current ADC value is: 437

[7] Autoseroll (Mewline +| 9800 baud |

2.2.3. H&N525

AT 3 ELBERE AT AT AR, T RIS 28 MR R 75 38—, 75 S
AT P R A RS 21T IS 28, BERT LA BN, Rt
Fiif S 075 3, T DR T A AR5 5 JS U0, Rt B 025 5 75

BAENIR:

G T T EREF o T LAY SIS 2505 2% ] 5L 1) 35 2 o

2.2.4. %% LED

Z ¥ LED &1L PWM i 73 I HI AT ER B Ry Gy B =/ LED & fr LLR /R AN RIS B
—JFEERAM T LB R EE NG,

BAENIR:

PRI T ERRET . ATLAE ] RGB SEHL = Al AL i

2.2.5. REfERE: LM75B

LM75B & — 3K SCHF 12C 45 IR A Ay, NP B v, (AN AR s Rl A At ] DAL
fEo NANERA 3 AT EZHI AL E M, 15— S BTN ERE 8 DM IFIA K
658 01| UL

10
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ORI -

A5 A ] LR DMV ARTERT LM75 FIT LM75A
12C M2, [F— Rk BRIk 8 AN, S ZEEETTIA 400KHz, B MK
MIhhe, MERMEWE, BiiBitas
AL LR B . 2.8V~5.5V

WESIREEVEE : -55°C~125°C

M &5y #E%: 0.125°C

MR

-25°C~100C: ®% 2°C

55C~125°C: ##% 3C

FERTIFE, KW IR 1.0pA

ESD {4

LM75 1E Ry MHLhE R 7 71 .

1=r HF, O=fikF-F

MSB LSB
1 0 0 1 A2 Al AO

ftkrf A2/A1/A0 5l ER a2, Bt LANLBIE B2 0x48.

BAENIE:

G EIF N AR $$, 77T Arduino IDE H 75 ) R A0 A « 23 BoR BT IR R R
TRt LM75 386, IR R AR, BB ST K

11
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WIS

WAVESHARE ELECTRONICS

.

COM4

The current temperature
The current temperature
The current tempersture
The current temperature
The current temperature
The current temperature
The current temperature
The current temperature
The current temperature
The current tempersture

The current temperature

is:
is:
is:
is:
is:
is:
is:
is:
is:
is:

is:

21.
21.
25.
7.00
27.
7.
28.
28.
28.
28.
25.

62
G2
62

50
a7
00
00
00
62
50

m

Autoscroll

:Neuline

v | (9600 baud

-

2.2.6. ZEHMIERE 1+ : ADXL345

ADXL345 & ADI 2~ 5] HE H 0 — 2K/ N T i B AR IO RE 3 Fhnid 2 1h, 13bit Rk 4

mg/LSB, T iA+16g. HUv i N 16 fr —HEHIHME R, FHELE sPI (3 £k 4
2 B 12C U U] . ADXL345 AEFE SRR N o B AT DATEMURR I S A e
157 3% (3.9mg/LSB)

A E A L, B W] AN IS 3 sl i S BN sl i

RERE I AN E 1.0° BOMIRE A BEAR AL

O PR R «

BRIEMBLS:

HIR RS 2.0V & 3.6V

I/0 HiRJEH]: 1.7v % vcc
EFEVEH: -40°CZE+85C

R~F: 3mmx5mm x Imm, LGA $t3%

Gn EIF N AR $$., 77T Arduino IDE [ 7 985 LGS o 23 S 2 AT AR =l
o B RIIE RN, BRI R, St E A A A2 fe, BARBLS N T &

MAs vi.2, 2015 4E5 H 7 H
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|
X=1.53 ¥Y=0.08 ZI=09.06 |~
X=1.49 Y= 0.08 I=9.02
X =153 ¥=0.08 ZI=0.18

X=000 Y= -10.12 Z= -2.16

X =-0.04 ¥=-10.04 Z= -2.35

X¥=6.83 Y= -8.12 I= -0.80 =
X =10.98 Y= -0.98 ZI= -2.00

X=11.14 ¥= -0.894 I= 0.47

X=0.8 ¥=0.20 IZ=9.14

Autoscroll :Nelline v: :9600 baud v:

2.2.7. SY5E XAAT$h: DS3231

DS3231 /K MA . mkERE 12C SERFIRHEF (RTC) » BASERMIEF AR 2 (Tcxo)
A IZA L A A\, T 3 BRI T ORI RE B R T B o BB S AR K
KAEm T8 KRR . I BT LAE R RD . 4r. B B B, ARERER, 2
T 31 RMHAG, KEZNEEAKREM, GFEEFEME.

O PRI »

TAEHE: 2.3V £ 5.5V
AR B
FH%: 0C%+70C
TolkZ: -40°CZE+85C
0°C £ +40°C K5 Z N+2ppm

®  -40°C E+85°CHEE N+3.5ppm

BIENIR:

g VEIT TR %ﬁ., 77T Arduino IDE H 47 ) L &% . ARG P S AL m 1)
AE: IR DV BT A TR] AT DU E Y BT R T

WA

13
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1 S5k B R B E TN A] . 020150207143000, 45 1 NEAFA 0, J5 HIFRAE(2015).

H(02). H(07). K(14). 43(30). F(00)3L 15 M5, AN E, w2 Sk A%,

REFHHIRECEE N ER: NEER08 24 /M BABKREUIN 15 MERF, Fl
m2 ARESK 02, HMBIERTERLL.

r com4

0
E @

020150207143000 e 1

2015.01.01 10:00:06
2015.01.01 10:00:07
2015.01.01 10:00:08
2015.01.01 10:00:09
2015.01.01 10:00:10
2015.01.01 10:00:11
2015.01.01 10:00:12
2015.02.07 14:30:00 - 3
2015.02.07 14:30:01
2015.02.07 14:30:02
2015.02.07 14:30:03
2015.02.07 14:30:04

S

=~

[¥] Autoscroll :Hevline v :9600 baud v

2.2.8. 0.96 =~f OLED: SSD1306

Accessory Shield B4 7 —#K 0.96inch, 128 x 64 /3 HEFR K/ OLED onBE, HFMinT:

® IXFhithF: SSD1306

® . IC

® Ziff: FIEXAI

® fifi: >160°

® [fEifE: -20C% 70°C
® [FffiEfE: -30°C % 80°C
BAENIR:

I N EAE, RBIRER RN T RARS EIERE, GfmmL. mE . RS,

2.2.9. XBee ¥

XBee /2 3 [H MaxStream 2 m] & T ZigBee BUARTIF A (1 — ik Te e AL Fn S , A2 A il H 1 42,
A gl & DT B RO, IF HSCRERI AT fir & 35T R Be & .

14
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LU

P~ XBee 1. /)™ Accessory Shield LA A& ™ Arduino UNO PLUS. N5 18 [l 12, AXFt
X WELHFR A A A B,

BIENIR:

1) 43 AIHE XBee AL N Accessory Shield [1] XBee #2171, Accessory Shield £ A\ Arduino JF
RIL, J@id usB 15 PC iz,

2)  WE Accessory Shield Bk4k:
® XD &% TX
®  RXD i%#% RX

VEE: THHBESAZ Arduino Y USB 2001 TX. RX &M, WHMRXSAT Arduino b
BATHRERFEA ST ORRE. RE, TUER TR—HHER, Flisehr
BN BRI

3)  HNIRIZAT X-CTU BAFEC & XBee ik, FLHin T :

PC Settings I Range Test | Teminal | Modem Configuration |

~Com Port Setup
Select Com Port

LISB Serial Port (COM4 Baud ISBUU vl
= vm H (COM1)

Flow Control |NONE v

Data Bits | 8 j'
Parity |NDNE :I'
Stop Bits I 1 v I
| P Test /Query l

4)  PCSettings IR HIEFEXT R 1, HWBIFRRFRESE, XBee L) BRINI
BN
® Baud: 9600

15
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Data Bits: 8

Flow Control: NONE
Parity: NONE

Stop Bits: 1

Xbee HEHLLE 1E 5 TAFE 2 BT w2t 47 AH B 1 132 B, X XBee FEE 1152 B Bk T 7T LLH X-CTU
X — T HSERZ A, ERT LA IR Xbee T AR AT 54, B H O&uGE K. N
R T8, AFMHEAHE x-cTu T A,

5)  Hi5 Test/Query, WE—VIIEHR, HIW FAEE. HBEESEOEE LR, 1LES
XBee FEHIEAS, 1HH AT USB LA Accessory Shield F kL.

‘Com test / QueryMo_de

Communication with modem.. 0K
Modem firmware version = 2047
Modem type = XB24-ZB

Serial Number = 134200404F59B1

Retry oK

6) | Modem Configuration &I+, st Read, BZHX XBee HEH MFTS4L:

16
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Wl

WAVESHARE ELECTRONICS

Modem Parameter Profile Remote Configuration.. Versions...

PC Settings | Range Test | Terminal Modem Configuration
— Modem Parameter and Firmware — - Parameter View - - Profile Versions
,WI Write | Restore I Clear Screen Save Download new

[T always Update Firmware Show Defaults Load YErsions...
Modem: XBEE Function Set Version

[xe24Z8 v | |ZIGBEE COORDINATOR AT

<l [mer =]

=43 Networking

..... h (1234) 1D - PAN ID

----- B (FFFF) SC - Scan Channels

----- B (315D - Scan Duration

~~~~~ B (0125 - ZigBee Stack Profile

~~~~~ B (FF)NJ - Node Jain Time

----- [@ (1234) OP - Operating PAN 1D

----- B (97ED) OI - Operating 16-bit PAN 1D
~~~~~ B (B)CH - Operating Channel

----- B (2] NC - Number of Remaining Children
=23 Addressing

~~~~~ B (134200) SH - Serial Number High
----- B (404F5981) 5L - Serial Number Low
----- B (0) MY - 16-bit Network Address

----- B (0) DH - Destination Address High

~~~~~ B (FFFF) DL - Destination Address Low
----- B (NI - Node Identifier

----- B (1E) NH - Magimum Hops

~~~~~ B (0 BH - Broadcast Radius

..... B1 (FE1 AR . b smitane Rante Brasdeact Time

m

Read parameters..OK

COM4 9600 8-N-1 FLOW:NONE XB24-ZB Ver2047 |

® [iiE XBee il A

fRA v1.2, 201545 H 7 H
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fuESHE

WAVESHARE ELECTRONICS

a)
b)
c)

d)

— =
BB [com4] x-CTU P
Modem Parameter Profile Remote Configuration.. Versions...
PC Settings I Range Test I Terminal Modem Configuration ]
-~ Modem Parameter and Firmware — - Parameter View - - Profile —— — Versions
Read | Wite « Restore | Clear Screen Save Download new
[~ Always Update Firmware I Show Default: Load VeIsions...
Modem: XBEE Function Set Wersion
[x82478 +] [ZIGBEE CODRDINATOR AT < | f0e7 |

=423 Networking

.. B (01D - PaN 1D

. @ (FFFF) SC - Scan Channels
- [l (315D - Scan Duration

. Bl (0)Z5 - ZigBee Stack Profile
B (FFINJ - Node Join Time

B OP - Operating P&N ID

- [@ 01 - Operating 16-bit PAN ID
- [@ CH - Operating Channel

B NC - Number of Remaining Children
=423 Addressing

- [ SH - Serial Number High

- @ 5L - Serial Number Low

- @ MY - 16-bit Network Address

- [ (0) DH - Destination Address High
. [ (FFFF) DL - Destination Address Low
- [l (1NI - Node Identifier

- B (1E) NH - Maximum Hops

B (0] BH - Broadcast Radius

,,,,, B (TR AR . M na Bonba

Rraadnast Tima

J |

Read parameters..0K

£F Function Set i%#% ZIGBEE COORDINATOR AT

H.1; Show Defaults
P PANID, BN 1234
il write, A BB 52

il & XBee #ilk B

MAs vi.2, 2015 4E5 H 7 H
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Q

eE,

'WAVESHARE ELECTRONICS

a)
b)
c)
d)

e)

~ Modem Parameter and Firmware —

Read | Write« Hestorel Clear Screen

Modem Parameter Profile Remote Configuration...
PC Settings ] Range Tesll Temminal  Modem Configuration l
- Parameter View | - Profile

Save

I~ Always Update Firmware

| Show Defaults L Load

Versions...

Versions
Download new
VETSIONs...

atchdog Timeout
- Channel Verification e

H [0)JN - Join Notification

- @ OP - Operating P&N 1D

- @ 01 - Dperating 16-bit P&N ID

- B CH - Operating Channel

----- B NC - Number of Remaining Children
-2 Addressing

----- [ SH - Serial Number High

- [@ 5L - Serial Number Low

- [@ MY - 16-bit Network Address
- @ (0)DH - De : High

ress Low

Modem: XBEE Function Set Version
XB24-78 | |2IGBEE ROUTER AT | |ea7 |
=423 Networking 2
B (01D - PN 1D 1
.. @ (FFFF)S an Channels
vvvvv B (315D - Scan Duration 3
..... BO tack Profile
..... BF No n Time

Change networking settings

[COM4  [9600 8N-1 FLOW:NONE XB24ZB Ver2047 |

fE Function Set Ni%¥¢ ZIGBEE ROUTER AT

#75 Show Defaults
ek PANID, 1BEN 1234

&+ Channel Verification(JV), &2~ 1-ENABLED

i Write, B BCE 58K

7)  iHEEELL T RECE LT XBee-A Al XBee-B, iZATHHN X-CTU, FF7E PC Settings &7

IR BEAFFEERE D, 2Rl A A1 B kAT .
TE X-CTU [ Terminal /1, FIAFRFRIENEIE G, & HBKILT] XBee-B L, FHAER

8)

> X-CTU ) Terminal * &R R HA i R R A E MR, 20 Rl 2 1 %k

¥
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i U BB (CoMA] X-CTU
About XModem... About XModem...

PC Sellingsl Range Test  Terminal I Modem Configuration I PC Sellings] Range Test Temminal | Modem Eonﬁguvalion]

Line Status—— ~Asset——————————— Line Status—— ~Asset—————————————

e S = Close | Assemble| Clear | Show: e S | [ Close | Assemble| Clear | Show
{ DTR IV [RTS ¥ [Break ‘ Com Port | Packet | Screen| Hex ’7‘ HDTHF RISV Break]—’ Com Port| Packet | Screen| Hex
123456abcdef i’ 123456abcdef il

= =
ECUMS [ 9600 8-N-1 FLOW:NONE [Rx: B bytes [ [COM4 | 9600 8-N-1 FLOW:NONE [Rx: 6 bytes [

9)
T2 BRI XBee #EHT T UK
%% XBee BB, SRJGTE S —A Arduino A5 i@t o 11 Hh 5 B T
HE, HFEERE Accessory Shield Bkk:
®  TXD % RX

RXD ## TX

WARIZATIRE N LR, T XBee MEBRAENS 1L IR HdE . F 7 AT LAFE Arduino
HR B R GE I Hil g Arduino 83 AR
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3.1. Arduino UNO PLUS

UNO PLUS 3% Arduino UNO R3 T R, Z:T ATMEGA328P-AU, Ui T UNO R3 [ &8
SR o

KREARTF R VEANE I T 251 % -

Hi3C: http://www.waveshare.net/shop/UNO-PLUS.htm

PEV . http://www.waveshare.com/product/UNO-PLUS.htm

21

MAs vi.2, 2015 4E5 H 7 H


http://www.waveshare.net/shop/UNO-PLUS.htm
http://www.waveshare.com/product/UNO-PLUS.htm

	产品概述
	板载资源
	产品使用
	Arduino IDE的使用
	库的导入
	程序编译和下载

	基础实验
	五向摇杆
	可调电位器
	蜂鸣器
	多彩 LED
	温度传感器：LM75B
	三轴加速度计：ADXL345
	高精度实时时钟：DS3231
	0.96 寸OLED：SSD1306
	XBee接口


	附录:
	Arduino UNO PLUS


